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Chapter 1  

Introduction 

The Marketing Operations Cookbook contains instructions for marketers and content 
authors who work with Sitecore. This guide contains step by step instructions on the 
key tasks involved in setting up and configuring Sitecore Analytics on your website. 
The subjects covered include creating profile cards and assigning them to content 
items, setting up goals, campaigns, and events, as well defining personalization rules 
and assigning them to content items. 

All of the examples in this cookbook use the Office Core website. This website is 
designed to highlight the functionality available in the Digital Marketing System.  

This cookbook contains the following chapters: 

¶ Chapter 1 ð Introduction 
This introduction contains a description of the content, aims, and the intended 
audience of this cookbook.  

¶ Chapter 2 ð Content Profiles 
This chapter provides step by step instructions on how to create profiles, goals, 
campaigns, multivariate tests, and personalization. It also includes instructions on 
configuring these items in the Page Editor. 

¶ Chapter 3 ð Goals, Campaigns, and Events 
This chapter provides step by step instructions on how to assign profile values to 
content items, how to associate goals and campaigns with content items, and how to 
assign events, failures, and settings. 

¶ Chapter 4 ð Patterns and Pattern Cards 
This chapter describes pattern cards and how to create them. 

¶ Chapter 5 ð Testing 
This chapter provides step by step instructions on how to create multivariate tests 
using the Page Editor and the Content Editor and how to evaluate your test results. 

¶ Chapter 6 ð Personalization 
This chapter provides step by step instructions on how to implement real time 
personalization using the Page Editor and the Content Editor. 

¶ Chapter 7 ð Viewing Reports 
This chapter describes the standard reports that are available in the Engagement 
Analytics report viewer. 
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1.1 The Sitecore Customer Engagement Platform 

The Sitecore Engagement Analytics brings together web content management, analytics, and 
marketing automation in one powerful suite of tools. Normally, you would have to spend a lot of time 
and money integrating any number of different 3

rd
 party products and tools to achieve this but Sitecore 

Engagement Analytics gives it all to you in one streamlined task oriented set of tools. Sitecore 
Engagement Analytics allows you to create, manage, and measure the effectiveness of online and 
offline campaigns. You can create profiles and measure how well visitors match these profiles and 
then display personalized content to these visitors on the fly. 

Sitecore Engagement Analytics helps you understand who your customers are and what they want to 
accomplish when they visit your web site. Sitecore Engagement Analytics generates a visitor profile 
for every visitor based on the pages they visit and their behavior during the visit. With Sitecore 
Engagement Analytics, content profiling becomes a natural part of content creation and can be 
implemented by every content author. You can easily adjust your content profiles as you get to 
understand more about your visitors and their behavior.  

Sitecore Engagement Analytics allows you to build detailed profiles of the visitors to your web site ð 
even first time visitors. You can see how they came to your website, what they searched for that 
brought them to your site, as well as what they searched for on your site. You can see which pages 
and content they visited, as well as the paths they used to reach that content. You can also see which 
goals they achieved on your website and any information that they entered in the forms that your 
website contains. You can use these rich profiles to push personalized content to visitors that match 
the different profiles that you have defined for your website. 

One component in Sitecore Engagement Analytics is the Executive Dashboard that contains large 
number of reports that help you analyze and quantify the results that your campaigns and your 
website are achieving. This lets to make informed decisions about the design, structure, and content 
of your website and the campaigns that you run. 

Sitecore Engagement Analytics lets you configure multivariate and A/B tests out of the box without the 
assistance of any developers. These tests allow you to fine tune your campaigns and evaluate their 
success. Sitecore Engagement Analytics gives you an unprecedented understanding of your online 
campaigns, and lets you see how each campaign meets the goals of your website and how many 
conversions it achieves. Sitecore Engagement Analytics helps you track newsletter campaigns, 
Google Adwords, online ads, and any other online initiative, so that you can find out more about each 
respondent. You can see what they did once they reached your site and what content they viewed. 

When the same visitor comes to your website several times, each individual session is tied together 
by a global cookie to give you an integrated picture of the visitorôs profile, history, preferences, as well 
as what brought them to your website in the first place. This integrated picture gives you far greater 
insight into the behavior of your visitors and into the success or failure of you campaigns than CPC 
(Cost per Click) or CPM (Cost per Impression) because you can associate multiple visits, goals, 
actions, and types of visitor with each campaign. This lets you focus your activity on the campaigns 
that give the greatest return and improve or cancel the campaigns that are underperforming.  

Sitecore Engagement Analytics gives your sales team instant information about any prospects that 
visit your website. New prospects are identified by the profile and score that their activity on your 
website generates ð what they downloaded, what they searched for, and what they viewed. Existing 
prospects can also be identified by the GeoIP information that the Sitecore Engagement Analytics 
reports contain. This GeoIP information includes the country, state, city, and the registered company 
name of every visitor. This information is correlated with the visitorôs activity on your website and can 
be easily integrated with leading CRM products. All of this combines to give your sales team qualified 
leads and unique insight into the needs and interests of new prospects and ultimately helps you to 
achieve online success. 

Security Roles and Sitecore Engagement Analytics 

You must be a member of certain Sitecore security roles to access the functionality in Sitecore 
Engagement Analytics. 
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The important Sitecore Engagement Analytics security roles are: 
 

Security Role Grants  

Client Authoring Access to the Marketing Center. 

Analytics Reporting Access to the Engagement Plan Monitor and to the Executive 
Dashboard. 
Requires membership of the Client Authoring role. 

Analytics Maintaining Access to the Engagement Plan Designer and Supervisor.  
Requires membership of the Client Authoring role. 

Analytics Testing Access to the Test Lab in the Marketing Center as well as 
access to the test functionality in the Page Editor and in the 
Content Editor. 
Requires membership of the Client Authoring role. 
Members of this role can create and edit test variations. 
Users who are not members of this role can switch test 
variations. 
Members of the Minimal Page Editor role cannot switch test 
variations. 

Analytics Personalization Access to the personalization functionality in the Page Editor 
and in the Content Editor. 
Requires membership of the Client Authoring role. 
Members of this role can create and edit personalization 
rules. 
Users who are not members of this role can switch 
personalization variations. 
Members of the Minimal Page Editor role cannot switch 
personalization variations. 

Analytics Content Profiling Access to the content profiling functionality in the Page Editor 
and in the Content Editor. 
Requires membership of the Client Authoring role. 

All of the analytics roles are members of the Client Users security role. 

 



Marketing Operations Cookbook   

 

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The 
contents of this document are the property of Sitecore. Copyright © 2001-2011 Sitecore. All rights reserved.  

Page 7 of 94 

Chapter 2  

Content Profiles 

In Sitecore, you must assign content profile values to all of the content on your 
website. These values are then used to create a profile of each individual visitor as 
they move through your website. You can also create some goals that you want your 
visitors to achieve when they visit the site.  

This chapter describes how content profiling works and contains step by step 
instructions for creating profile cards and for assigning profile cards to content items. 

This chapter contains the following sections: 

¶ Content Profiling 

¶ Profiles, Profile Keys, and Profile Cards 

¶ Assigning a Profile Card to a Content Item in the Content Editor 

¶ Assigning a Profile Card to a Content Item in the Page Editor 
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2.1 Content Profiling 

By assigning content profile values to all of the items that make up your website you are able to gain a 
better understanding of the behavior, actions, and interests of your website visitors. As a visitor moves 
through your website they are assigned the content profile values that you have defined for each item 
they visit. These values accumulate as the visitor navigates through the site and help you build up a 
profile of the visitor. 

Marketers create content profiles, profile keys, and profile cards in the Marketing Center and content 
authors use the Content Editor to assign profile values to the contents of each web page. You can 
assign profile values to every Sitecore item that you use on your website. 

2.1.1 Profile Values, Web Pages, and Content Items 

It is important to understand the difference between a web page and a Sitecore content item and how 
this affects the profile score that visitors accumulate as they navigate through the website.  

In Sitecore, a web page is not a single entity but consists of numerous Sitecore items. When a visitor 
views a page they are assigned the profile values of the item identified in the URL for that page and 
are not assigned the profile values of all the items that make up the page.  

2.1.2 Pre-requisites 

Before you assign profile values to content items you should consider creating: 

¶ Website personas ð the personas that your website is designed for. These are also the 
personas that your content authors should have in mind when they create the content that 
you use on your website. 

¶ A profiling strategy ð an understanding of the content on your website and the personas it is 
designed for. This understanding helps you assign the appropriate profile values to the 
content of your website. 

Personas 

When you design your website, you should create some personas that correspond to the different 
types of people that you want to visit your website. 

Personas are fictional characters that represent different user types within your target demographic, 
attitude, and/or behavior set that might use your site in a similar way. A persona describes the life, 
habits, background, interests, and profession of a fictional character.  

Having a good understanding of the market segments or demographics that your website seeks to 
attract makes it easier for you to create these personas and to design your website.  

When your designers and content authors create your website and write the content for it they should 
ensure that it contains content that appeals to these personas.  

Profile Cards 

Creating profile cards and profile keys enables you to categorize the content on your website and 
ultimately helps you to classify the visitors to your website.  

The profile cards and keys that you create should reflect the interests of the personas that you 
designed your website for. When a visitor views a page on your website, they receive the profile 
values that you have assigned to that content item. As the visitor navigates through the website, they 
accumulate the profile values of all the pages they visit and this gives you an insight into the different 
kinds of content that they are interested in. The profile values that visitors accumulate are displayed 
as a bar chart in the session trail.  
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All of the information that you collect about the visitors to your website, the pages they view, the goals 
they complete, and the path they use to navigate through the site can help content authors to identify 
areas of the website that could benefit from improvement. You can also use this information to 
segment the visitors to your website and to create rules for personalization. 

Profile Values 

The profile values that a visitor accumulates during a visit give you an insight into the visitorôs level of 
interest in your website. For example, assigning a high lead profile value to an item, such as a 
brochure download page, means that when a visitor views this page they are demonstrating a high 
level of interest in reading one of your brochures and are potentially interested in buying one of your 
products and can be targeted as a potential sales lead. 

This information can be particularly useful to your sales team. For example, if a visitor achieves a high 
lead profile value, this can indicate that they are a potential customer and therefore represent a sales 
opportunity. 

Examples of profile values: 
 

Profile Values Example 

Lead Pages related to price carry a high lead profile value on your 
website. Knowing which visitors achieve a high lead profile value 
can help your sales team to target potential new customers. 

Investor A visitor has viewed the annual report page on your site. Assigning 
a high investor profile value to this page can help you identify 
visitors that are interested in investing in your company. 

Big spender Assigning a high profile value to a page that records the total 
purchase amount used by visitors to your site can indicate which 
visitors are the biggest spenders.  

To demonstrate this concept, the Office Core website is configured to record Lead profile values. The 
deeper a visitor navigates into the website, the higher is the lead profile value that they accumulate. 
Some pages and actions carry higher lead profile values than others. For example, downloading a 
brochure carries a high lead profile value.  

The Engagement Analytics application contains the lead reports and you can drill down to the session 
trail to see the lead profile values accumulated by each visitor. 
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2.2 Profiles, Profile Keys, and Profile Cards 

A web site can consist of any number of pages. When you assign profile values to each page it can 
be very difficult to ensure that you assign them consistently across the entire website. 

To facilitate the process of assigning profile values to content items, Sitecore lets you create profile 
cards that contain a specific set of profile values. You can use these cards to assign these predefined 
profile values to content items.  

Sitecore Engagement Analytics comes with some predefined profiles that illustrate a number of these 
key concepts. Each of these profiles has been assigned some profile keys. 

 

The predefined profiles and profile keys are: 
 

Profiles  Profile Keys 

Focus Background 

Practical 

Process 

Scope 

Function Building Trust 

Call to Action 

Create Desire 

Define Concept 

Persona Cecile 

Chris 

Ian 

Sandra 

Score Lead 

Focus 

This profile contains profile keys that you can use to indicate the emphasis that each content item 
has. Does the content item contain mainly background information or does it focus on practical 
information? 
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Function 

This profile contains profile keys that you can use to indicate the purpose of each content item. Is the 
content item designed to build trust in your products or to increase the visitorôs desire to own one of 
the products? 

Persona 

This profile could be used to contain the profile keys that reflect the personas that you use when you 
design your website. 

Score 

This profile contains the lead value that you can assign to each content item. Does viewing this 
content item indicate that the visitor is a potential customer or not? 

Under each profile you can also create any number of profile cards that contain predefined profile 
values that you can assign to the content items on your website.  

2.2.1 Creating a Profile Card 

Before you start assigning profile values to the content items that make up your website, you will 
probably need to create some new profile cards. 

Important 
A profile card is not the same as a persona. A persona describes the life, habits, background, 
interests, and profession of a fictional character and therefore contains aspects from all of the profiles. 
A profile card only refers to the aspects of a single profile. 

Before you start to create profile cards, you should consider the profiles that are suitable for your 
website and whether it is appropriate to assign one or more profile cards for each profile to the 
content items that make up your website. If you decide that it is appropriate to assign multiple profile 
cards, you should also specify whether you want to be able to specify the relative importance that the 
content item has for each profile card. 

To specify how many profile cards you can assign to content items: 

1. Click the Sitecore menu and then click Marketing Center. 

2. In the Marketing Center, expand the content tree and click Profiles. 

3. Select the profile that you are interested in and then click the Profile Cards folder. 
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4. On the Content tab, in the Authoring Selection field, click the drop-down arrow and select 
one of the options. 

 

The options are: 
 

Option Description 

Single You can only assign one profile card to each content item. 

Multiple You can assign several profile cards to each content item. 

Multiple with Percentages You can assign several profile cards to each content item 
and assign a percentage weighting to each profile card. 

To create a profile card: 

1. Click the Sitecore menu and then click Marketing Center. 

2. In the Marketing Center, expand the content tree and click Profiles. Select the profile that 
you are interested in and then click the Profile Cards folder. 

3. In the Home tab, in the Insert group, click Profile Card to create a new profile card. 

 

4. Give the profile card a name, such as, Decision Maker.  
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Assigning Profile Values to a Profile Card 

After you create the profile card, you can assign some appropriate profile values to this card. 

To assign profile values to a profile card: 

1. In the Marketing Center, select the new profile card.  

2. In the Content tab, scroll down to the Profile Card Value field. 

3. In the Profile Card Value field, select the profile values that you want to assign to this card. 

 

This item also contains a number of other fields that you can use to enter background 
information about this profile that may be useful for content authors who are not familiar with 
your target demographics. 

You can create as many profile cards for each profile as you need. 

4.  In the ribbon, click Save. 

You can create any number of profiles and profile keys but it is worthwhile planning a profiling 
strategy before you start creating profiles and profile cards. 
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2.3 Assigning a Profile Card to a Content Item in the Content 
Editor 

After you have created the profile cards and assigned profile values to them, you can start assigning 
the profile cards to the content items that make up your website. Assigning profile cards to content 
items makes it easier for you to implement profile values consistently across your website.  

To assign a profile card to a content item: 

1. In the Content Editor, navigate to the item that you want to assign a profile card to. 

 

2. On the Content tab, click the profile card icon in the top right-hand corner and the Profile 
Cards dialog box appears. 
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3. In the Profile Cards dialog box, select the profile that you are interested in and click Edit and 
the Select Profile Card dialog box appears. 

The Select Profile Cards dialog box looks different depending on which option you selected 
earlier in the Authoring Selection field. 

The options are: 
 

Option Description 

Single You can only assign one profile card to each content 
item. 

Multiple You can assign several profile cards to each content 
item. 

Multiple with Percentages You can assign several profile cards to each content 
item and assign percentages to each profile card. 

If you selected the Single option in the Authoring Selection field, the Select Profile Cards 
dialog box looks like this: 

 

4. In the Select Profile Cards dialog box, in the Profile Cards field, select the profile card that 
you want to assign to this content item and the profile values that you gave to this card are 
assigned to the current content item. 
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If you selected the Multiple option in the Authoring Selection field, the Select Profile Cards 
dialog box looks like this: 

 

5. In the Profile Cards field, select the profile cards that you want to assign to this content item 
and click Add. 

 

The total value of the all the profile cards that you select is assigned to the content item.  
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If you selected the Multiple with Percentages option in the Authoring Selection field, the 
Select Profile Cards dialog box looks like this: 

 

6. In the Profile Cards field, select the profile cards that you want to assign to this content item 
and click Add. 
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7. In the Profile Card Details field, in the drop down box for each profile card, select the 
percentage of importance/relevance that you want to assign to each profile card. 

 

The sum of the percentages that you select must be 100%.  

If the sum of the percentages that you select is not 100%, Sitecore displays a message 
informing you of this and that allows you to recalculate the percentages automatically or to 
change them manually. 

If you decide that Sitecore should recalculate the percentages automatically, it increases or 
decreases the percentages proportionally. 

After you have assigned some profile cards to the content item, the Profile Cards dialog box 
reflects the changes you have made. 
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When you have assigned some profile cards to the content item, it displays some more information at 
the top of the Content tab. 

 

The Content tab now displays an icon for each of the profile cards that you have assigned to this 
content item.  

When you move the mouse over one of the profile card icons the Content Editor displays a tooltip 
that tells you what profile card it is.  

 

2.3.1 Assigning Custom Profile Values to a Content Item in the 
Content Editor 

When you are assigning profile values to the content items on your website, there could be some 
content items for which the profile cards that you have created are not appropriate. In these cases, 
you can assign custom profile values to the content item. 

Important 
You can only assign custom profile values to content items if you select Single in the Authoring 
Selection field when you decide which kind of profile cards you want to use. 

To assign custom profile values to a content item: 

1. In the Content Editor, navigate to the content item that you want to assign profile values to. 
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2. In the Content pane, select the profile that you want to create custom profile values for and 
assign to the content item. 

 

3. In the Select Profile Card dialog box, click Customize. 

4. In the Customize section, click the drop down arrow for each profile value and select the 
values that you want to assign to the content item. 

 

5. Click OK to save your changes. The profile values you selected are assigned to this content 
item. 
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2.4 Assigning a Profile Card to a Content Item in the Page 
Editor 

When content authors use the Page Editor to create and edit the content items that make up your 
website, they can also assign profile values and profile cards to these items. 

To assign profile cards and profile values to an item in the Page Editor: 

1. In the Page Editor, navigate to the page that contains the item that you want to assign profile 
values to and expand the ribbon. 

 

2. In the ribbon, in the Analyze group, click Profiles to open the Profile Cards dialog box. 

 

3. The functionality available here is the same as in the Content Editor.  

For more information about assigning profile cards, see the section Assigning a Profile Card to a 
Content Item in the Content Editor. 
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Chapter 3  

Goals, Campaigns, and Events 

Sitecore lets you manage your marketing campaigns and use them to engage with 
your customers. You can also create goals and events that can be associated with 
these campaigns and help you measure the success of your campaign activities ð 
both online and offline. 

Furthermore, you can specify that visitors who participate in a campaign and come to 
a particular landing page are automatically assigned to a state in an engagement 
plan. 

This chapter contains the following sections: 

¶ Goal 

¶ Campaign 

¶ Events 

¶ Analytics Page Settings 
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3.1 Goals 

You create goals to measure the success of your website and your marketing campaigns ð both 
online and offline.  

You can create a goal for any activity that visitors can perform on your website. 

Examples of goals:  

¶ Download a brochure 

¶ Register for an e-mail newsletter 

¶ Visit a particular page 

¶ Sign up for an online demo 

Once you have created some goals, you can measure the conversion rate for each goal ð the 
percentage of visitors that achieve a particular goal. The website performance reports show goals and 
conversion rates. 

You can create an engagement plan that uses goals to evaluate what action should be taken. For 
more information about engagement plans, see the Engagement Automation Cookbook. 

You can create personalization rules that are based on the goals that a visitor achieves. For more 
information about personalization rules, see the section Personalization. 

3.1.1 Creating a Goal 

To create a new goal: 

1. Open the Marketing Center and click Goals.  

2. On the Home tab, Insert group, click Goal to create a new goal definition item. 

 

3. Give the goal a name, such as, Arch Digest Sign-up. 
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4. In the new goal definition item, enter the appropriate values. 

 

 

Field Value 

Name The name for your goal.  

Points The number of engagement value points that are assigned to a 
visitor when they achieve this goal. 
 
Every time a visitor lands on a page that has a goal or page event 
associated with it, they accumulate the engagement value points 
that are assigned to that event or goal. When the visitor leaves the 
website this score becomes the engagement value for that visit.  
The number of engagement value points allocated to each goal is 
not important but the ratio between engagement value points 
assigned to the different goals is. For example, the marketer must 
understand why the Request for Demo goal is four times more 
valuable than the Newsletter Registration goal. 

Category A suitable description, such as, User has registered for Arch 
Digest. 

Description This defines the event as a system event. 
For administrators and advanced users only. 

Rule Select the rule that should be evaluated when the page event 
associated with this goal is triggered. 

IsAuthorFeedback Select this checkbox if the page events associated with this goal 
are of interest to content authors. 

IsFailure Select this checkbox to define the event as a failure.  
For administrators and advanced users only. 

IsGoal Select this checkbox to ensure that the goal appears in the 
Content Editor, Goals dialog box. You can then associate the 
goal with a content item. 

IsSystem Select this checkbox if the page event describes a system event. 

5. Click Save to save the new goal. 
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Engagement Value Points 

When you create a goal, you can assign some engagement value points to it. The number of 
engagement value points that you assign should reflect the value that you ascribe to each goal. You 
can also assign profile cards and profile values to each goal. Every time a visitor achieves a goal, 
Sitecore assigns these profile values and engagement value points to their profile. This allows you to 
measure the engagement value of each visit as well as the accumulated engagement value of each 
visitor. 

You can create personalization rules that are based on the number of engagement value points that a 
visitor accumulates. You can also create engagement plans that evaluate the number of engagement 
value points that a visitor has achieved to determine what action should be taken. 

For more information about engagement value points and engagement value, see the Executive 
Dashboard Cookbook. 

For more information about personalization rules, see the section Personalization. 

For more information about engagement plans, see the Engagement Automation Cookbook. 

3.1.2 Deploying and Publishing a Goal 

When you create a goal, it is subject to a workflow. You must deploy the new goal before it becomes 
available in the Marketing Center and you can associate it with a content item or a campaign. 

To deploy a goal: 

1. In the Marketing Center, select the goal that you want to deploy. 

2. On the Review tab, in the Workflow group, click Deploy. 

 

The new goal is now available in the Marketing Center and you can associate it with content items 
and use it in your campaigns. 

However, like every other item, a goal must also be published on your website before it is available to 
your website visitors. 

3.1.3 Associating a Goal with a Content Item 

After you have created a goal and deployed it, you can associate it with a content item. This means 
that the goal is achieved every time a visitor views this item.  
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In this example, we associate the goal with a landing page that contains a form that lets visitors who 
read a magazine called Architectural Digest sign up for a site audit at a 50% reduction. 

To associate a goal with a content item: 

1. In the Content Editor, navigate to the content item you are interested in. In this example we 
want to associate the goal with a landing page. 

2. Click the Analyze tab and in the Attributes group, click Goals. 

 

3. In the Goals dialog box, select the goal that you want to associate with this item. 

In this example, we associate the Arch Digest Sign-up goal with a landing page that contains 
the form that the visitor must use to avail of the offer. 
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3.2 Campaigns 

A campaign is a promotion or advertising initiative designed to encourage people to come to a 
website and perform some desired actions. 

Sitecore Analytics supports two types of campaigns: 

¶ Online Campaigns 

¶ Offline Campaigns  

You can view reports that show which of your campaigns are the most successful. You can then 
improve or drop unsuccessful campaigns and improve your ROI. 

You can create an engagement plan that uses campaigns to evaluate what action should be taken. 
For more information about engagement plans, see the Engagement Automation Cookbook. 

You can create personalization rules that are based on the campaigns that a visitor takes part in. For 
more information about personalization rules, see the section Personalization. 

3.2.1 Creating a Campaign 

To create a campaign: 

1. In the Marketing Center, click Campaigns, and then on the Home tab, in the Insert group, 
click Campaign.  

2. Give your new campaign a name, such as, Architectural Digest and click OK. 
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3. In the new campaign item, enter the appropriate values. 

 

 

Field Value 

Title The title of the campaign. 

Type The type of campaign ð whether it is an online or offline 
campaign. 

Organic Whether or not the traffic type should be changed if this 
campaign is triggered. 

Traffic Type The type of traffic ð how the visitor came to the website. 

Enroll in Engagement 
Plan 

Select the engagement plan state that you would like to 
assign visitors to when they participate in this campaign. 

StartDate The start date for the campaign. 

EndDate The end date for the campaign. 

Cost  

Cost Base  

Cost per Click  

Cost per Day  

Hidden Whether or not the campaign should be shown in reports. 
For example, you may not want to show campaigns that are 
created automatically in your campaign reports. 

4. Click Save to save the new campaign. 

For more information about engagement plans, see the Engagement Automation Cookbook. 

Deploy the Campaign 

You must deploy the new campaign item to ensure that it is available in the Marketing Center. If the 
campaign is not available, you cannot associate it with a content item.  
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To deploy a campaign: 

1. In the Marketing Center, select the campaign that you want to deploy. 

2. On the Review tab, in the Workflow group, click Deploy. 

3.2.2 Associating a Campaign with a Content Item 

You must also associate the campaign with the appropriate content items. 

To associate a campaign with a content item: 

1. In the Content Editor, expand the content tree and navigate to the content item that you want 
to associate a campaign with.  

In this example we are using a landing page. 

2. On the Analyze tab, in the Attributes group, click Attributes. 

 

3. In the Attributes dialog box, click the Campaigns tab and then select the campaign that you 
want to associate with the content item. 

Publishing the Goals and Campaigns 

You must publish the new goals and campaign items to make them available on your website 

¶ In the Publishing wizard, select the Smart Publish option. 

3.2.3 Viewing the Results of Your Campaign 

After you have published the relevant items on your website, you can launch your campaign to attract 
visitors to come to your website and achieve the goals that you have defined.  

Once visitors can access these pages and achieve these goals, you can view the statistics generated 
by their visits and evaluate the value achieved by your campaigns. 

To view the visitor activity: 

1. In the Sitecore Desktop, click Sitecore, Engagement Analytics. 
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2. In the Engagement Analytics dialog box, expand the Recent Activities node and then click 
Latest Visits. 

 

As you can see, the Value column shows that some of the visitors have visited the page 
associated with the campaign, achieved the goal, and scored some points. 

You can drill down into each session to get more detailed information about each visit. 

For more information about the reports that are available in the Engagement Analytics 
dialog box, see the Marketing Operations Cookbook. 
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3.3 Events 

You can use events to track user activity on a website. You can track events, such as, download, 
search, registration, or logout. Tracking events help to build up a more comprehensive picture of a 
visitorôs behavior as they navigate through the website. 

Goal and campaign events are triggered when visitors achieve certain objectives on the website or 
when they come to a site from a promotion or campaign that you have created. These events are 
tracked in Sitecore Engagement Analytics and appear in the campaign and conversion tracking 
reports. 

Sitecore administrators can edit existing events and create additional events if you need them. The 
marketer must remember to specify how many engagement value points should be assigned to each 
event. 

You can create engagement plans that use events to evaluate what action should be taken. For more 
information about engagement plans, see the Engagement Automation Cookbook. 

3.3.1 Associating an Event with a Content Item 

You can associate events with content items.  

To assign an event to a content item:  

1. In the Content Editor, expand the content tree and navigate to the content item that you want 
to associate an event with.  

2. In the Analyze tab, in the Attributes group, click Attributes to open the Attributes dialog 
box. 

 

3. In the Attributes dialog box, click the Events tab, and select the event that you want to 
associate with the content item. 

4. Click OK to save your changes and close the Attributes dialog box.  
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3.3.2 Assigning Failure Actions to Items 

Failure actions are another type of event. Normally page failures are recorded programmatically. You 
can, however, use failure actions to record any page failures that occur on the website.  

For example, if you have an error page that you display to site visitors when an error occurs, you can 
associate a failure action such as Page Error with this page. Then when a visitor sees this page, a 
page error is recorded in Sitecore Analytics and you can track all the page errors that occur on your 
site in this way. 

To associate a failure action with a content item: 

1. In the Content Editor, expand the content tree and navigate to the content item that you want 
to associate an event with. 

2. In the Analyze tab, in the Attributes group, click Attributes to open the Attributes dialog 
box. 

 

3. In the Attributes dialog box, click the Failure Actions tab, and select the event that you want 
to associate with the content item. 

4. Click OK to save your changes and close the Attributes dialog box. 

3.3.3 Engagement Value Points and Events 

Sitecore administrators can create any extra events that you may need. They can also specify the 
number of engagement value points that you want to assign to each event.  

Every time a visitor lands on a page that has an event associated with it, they accumulate the 
engagement value points that are assigned to that event. When the visitor leaves the website this 
score becomes the engagement value for that visit.  






























































































































